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About this Document
History of Changes

1 About this Document
In this section we provide information about the document on hand.

1.1 History of Changes

Date Changes Reason

24/05/2023 Initialization of document UCBE-32632

25/10/2023 Added:

• Configuration of
OpenScape Add-
ins Deployment
Parameters

• Setup of OpenScape
Add-ins custom
plugin controller

UCBE-33641

22/02/2024 Updated:

• Setup of OpenScape
Add-ins custom
plugin controller

UCBE-34171

1.2 Markups used

In this document we use the following markups to highlight specific passages.

Element Markup

GUI elements Select Save to …

Sequence of menu items Users& Resources > Resources

Command line output C:> unknown command

System input Enter true in the ... field.

Directory and file names /var/config.xml

File contents conname=%CONNECTION_NAME%

Names of keyboard keys Push Esc to …

Specifications with varying content <user name>

1.3 Notes

Types of notes

Critical notes and additional information are indicated in this manual in the
following manner:
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About this Document
Continuative Documentation

NOTICE:  Denotes information worth knowing or useful tips.

IMPORTANT:  Denotes information of high priority. Please
definitely read and heed such notes to avoid malfunctions, loss
of data or damage to devices.

1.4 Continuative Documentation

You can find further information about OpenScape UC Desktop App in the
following documentation:

• OpenScape UC Application V10, UC Desktop App, User Guide
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2 Introduction
This guide describes how to download, install and make use of the Openscape
Add-ins integration.

2.1 OpenScape Add-ins

OpenScape Add-ins is an integration between OpenScape UC and Microsoft
Outlook. It extends Microsoft Outlook with features provided by OpenScape UC.

It allows you to access OpenScape UC contacts, call history, conferences,
surveys, voicemail and chats directly from Microsoft Outlook.

With OpenScape Add-ins, you can easily:

• Call an email originator by email, number or name
• Start a conference with people from an email
• Start a chat
• Activate Tell-me-when
• Access OpenScape UC features, in particular:

– Contacts
– Call history
– Conference
– Surveys
– Voicemail
– Chat

• Set your OpenScape UC presence state
• Select a preferred device to be used for incoming and outgoing calls
• Access the settings of an outgoing device

2.2 Prerequisites

• You have a Microsoft Outlook account.
• You have an OpenScape UC account.
• On a desktop computer, for the best possible user experience when working

with OpenScape Add-ins, it is mandatory that OpenScape Desktop App is
installed.

• You have downloaded and installed the OpenScape Add-ins integration.

2.3 Supported platforms

You can use OpenScape Add-ins on an Windows computer.
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3 How to download and install OpenScape Add-ins
To integrate OpenScape UC with Microsoft Outlook, you need to download and
install OpenScape Add-ins.

This section describes how to set up OpenScape Add-ins for individual use.

Follow the steps below to download and install the integration on your
computer:

Prerequisites

• Your system administrator has enabled the OpenScape Add-ins download
option on your system.

For more information, see chapter "How to enable the OpenScape Add-ins
download option" in  OpenScape UC Application V10, Configuration and
Administration, Administrator Documentation.

Step by Step

1) In your UC client, click on your user name.
A menu with the available options is displayed.

2) Click Settings.
3) Under the General tab, locate the OpenScape Add-ins area and click

Download OpenScape Add-ins.
A zip file containing the OpenScape UC for Microsoft Outlook integration
files is downloaded to your computer.

4) Locate the zip file (usually in the Download folder) and extract it.

The following file is extracted:

• OpenScapeAddIns.exe

5) Double-click on the OpenScapeAddIns.exe file to start the installation
process.
The installation wizard opens.

6) Follow the instructions on the installation wizard to install OpenScape Add-
ins.

To successfully complete the installation process, you might be prompted to:

• Stop any running instances of Microsoft Outlook and OpenScape Desktop
App.

• Restart the Microsoft Outlook client.
• Restart your computer.
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4 How to enable or disable OpenScape Add-ins
Follow the steps below to enable or disable the OpenScape Add-ins integration
from Microsoft Outlook.

Prerequisites

• You have installed OpenScape Add-ins.

Step by Step

1) Open Microsoft Outlook and navigate to the File tab.
2) Click Options on the left navigation bar.

A pop-up window opens with Outlook options that you can customize.
3) Click Add-ins on the left navigation bar.
4) Select the COM Add-ins option from the Manage drop-down list, then click

Go.
A list of available add-ins is displayed.

5) Locate OpenScape for MS Office in the list and do one of the following
actions:

• Uncheck the checkbox next to it to disable the add-in

or
• Check the checkbox next to it to enable the add-in.

6) Click OK.
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5 How to uninstall OpenScape Add-ins
You can uninstall the OpenScape Add-ins integration in one of the following
ways from Windows Apps & features area or via mass installation.

To uninstall the integration from Windows Apps & features, follow the steps
below:

1) Open Windows search, type Apps & features and press Enter.

The Apps & features dialog opens and you can view the list of all apps
installed on your computer.

2) Search for or locate  OpenScape Add-ins in the list.
3) Click on it and select Uninstall.
4) Click Uninstall again to confirm the action.
5) Follow the instructions on the wizard to uninstall OpenScape Add-ins.

To uninstall the integration via mass installation, refer to chapter How to
uninstall OpenScape Add-ins via Mass Installation on page 17.
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6 How to perform the mass installation of OpenScape
Add-ins

This section describes how to perform a mass installation of OpenScape Add-
ins and make the integration available for multiple users or machines.

NOTICE:  Mass installations can be only triggered by a system
administrator.

6.1 How to setup installer command line parameters

The following command line parameters can be specified for the mass
installation of OpenScape Add-ins:

• /passive

no user interaction (progress bar only)
• /q, /quiet, /s, /silent

Use to run the installer in silent mode. That means no user feedback
• /norestart

When running in unattended or silent mode, if a reboot is required, it will be
done automatically, unless this option is used.

• /layout "path"

Only download remote payloads (prerequisites) from the internet and save
them to path.

• /log "path"

Change the default bundle's log file.
• /uninstall

uninstall
• /repair

repair
• InstallFolder="c:\Add-ins"

You can use this parameter to customize the OpenScape Add-ins installation
folder. This parameter is case sensitive.

By default, this parameter is not used. When it is not used, the OpenScape
Add-ins integration is installed in one of the following folders: Program
Files (x86) (for 64-bit systems) or Program Files (for 32-bit systems).

6.1.1 Configuration of OpenScape Add-ins Deployment Parameters

After successful installation of OpenScape Add-ins, the deployment.xml
deployment file is created. You can modify this file and configure the parameters
for a future mass installation.
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NOTICE:  It is recommended to create a copy of the
deployment.xml file and rename it according to the
parameters you want to configure.

Once the parameters are configured according to your needs, you can
run the installation command for OpenScape Add-ins. For example, you
can run the following command, where parameters are configured via the
deployment.xml file:

OpenScapeAddIns.exe /s DeploymentFile="c:\addins
\my_deployment.xml"

If your deployment file has a different file name, you must adapt the
DeploymentFile parameters accordingly.

Once the OpenScape Add-ins installation is completed, the deployment.xml
file is copied to the following path:

%programdata%\Unify\Fusion\deployment.xml

After installation, if you have administrator rights, you can modify the
OpenScape Add-ins installation at any time. For this, you need to do the
following steps:

1) First, modify the deployment.xml file according to your needs.
2) Then run the deployment_tool.exe executable file, located in the

%programdata%\Unify\Fusion path.
3) Restart the OpenScape UC Desktop Application to apply the changes.

You can find below the description of several deployment parameters:

• ODC_ContactCard_Enabled

This parameter specifies whether the Outlook Contact Card Plugin will be
installed.

• Outlook_Plugin_Enabled

This parameter specifies whether the Outlook Plugin will be installed on the
Microsoft Outlook Ribbon.

• Outlook_CalendarPlugin_Enabled

This parameter specifies whether the OpenScape Calendar Extension for
Microsoft Outlook will be installed.

• Outlook_Plugin_ChatButton_Enabled

This parameter can be set to True (default) or False.

If set to True, the chat button appears on the Microsoft Outlook Ribbon
and in the Connect to area of the Outlook Plugin.

If set to False, the chat button doesn't appear in any of the locations
mentioned above.

If this parameter is not configured, it is set to True by default.

6.1.2 Setup of OpenScape Add-ins custom plugin controller

You can setup the OpenScape Add-ins integration to include custom plugin
controller components for Microsoft Outlook.
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WARNING:  You can only install the custom plugin controller if:

• The OpenScape UC Desktop Application is closed

or
• The OpenScape UC Desktop Application has not been restarted after

installing OpenScape Add-ins.

To setup the custom plugin controller, you need to modify the
_._._.userscript file, located in the C:\ProgramData\Unify
\OpenScape path.

For example, the _._._.userscript can include the following content:

<configuration>
  <pc._._>
    <siemens.opticlient>
      <startup>       
        <lastlocation>OPENSCAPE</lastlocation>
        <linmode>None</linmode>       
        <locationselection>True</locationselection>       
        <languageselection>False</languageselection>       
        <usewindowslogin>True</usewindowslogin>       
        <listusers>True</listusers>            
              <useoslanguage>True</useoslanguage>         
   
              <adminmode>Full</adminmode>
      </startup>
    </siemens.opticlient>
  </pc._._>  <_.user._>
    <siemens.opticlient>
      <startup>
        <password>#</password>       
        <colorscheme>DarkGray</colorscheme>
      </startup>
    </siemens.opticlient>
  </_.user._>
</configuration>

The content below is required to make default changes to the Microsoft Outlook
Plugin Integration Controller components:

<unify.opticlient.pluginintegration.pluginintegration>
       <usepresencesynchronization>True</
usepresencesynchronization>
       <usedefaultconferencingoptions>False</
usedefaultconferencingoptions>
       <audioconferencerecordname>False</
audioconferencerecordname>
       <audioconferencemoderatedconference>False</
audioconferencemoderatedconference  
       <audioconferencedialoutdefault>False</
audioconferencedialoutdefault>  
       <standardlanguage>en</standardlanguage>
       <inv_ca>False</inv_ca>
       <inv_zh>False</inv_zh>
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       <inv_cs>False</inv_cs>
       <inv_nl>False</inv_nl>
       <inv_en>True</inv_en>
       <inv_fr>False</inv_fr>
       <inv_de>False</inv_de> 
       <inv_it>False</inv_it>
       <inv_pt_br>False</inv_pt_br> 
       <inv_pt>False</inv_pt>
       <inv_ru>False</inv_ru>
       <inv_es>False</inv_es>
</unify.opticlient.pluginintegration.pluginintegration>

It is possible to change the controller components, as described in the table
below:

IMPORTANT:

To change the default values, you must edit the
_._._.userscript file before the first login to the OpenScape
UC Desktop Application.

If the OpenScape UC Desktop Application has been started at
least once since its installation, changes of the default values
are only possible after completing the following steps:

1) Uninstall OpenScape Add-ins and OpenScape UC Desktop
Application.

2) Navigate to C:\Users\YourUser\AppData\Roaming and
delete the entire Unify content and directory.

3) Reinstall OpenScape UC Desktop Application and
OpenScape Add-ins.

Once the installations are completed, do not start any of the
applications.

4) Edit the default values in the _._._.userscript file
according to your need.

For example, change the default value for user presence
from
<userpresencesynchronization>True</
userpresencesynchronization>

to
<userpresencesynchronization>False</
userpresencesynchronization>

5) Start the OpenScape UC Desktop Application and
OpenScape Add-ins applications for the first time.

Feature Default
value

Change user presence to "In a meeting"

Compare:
<userpresencesynchronization>True</
userpresencesynchronization>

True
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Feature Default
value

Create conference with default settings

Compare:
<usedefaultconferencingoptions>False</
usedefaultconferencingoptions>

False

Request user name

Compare:
<audioconferencerecordname>False</
audioconferencerecordname>

False

Moderated conference

Compare:
<audioconferencemoderatedconference>False</
audioconferencemoderatedconference>

False

Dial out to participants

Compare:
<audioconferencedialoutdefault>False</
audioconferencedialoutdefault>

False

Standard Language

Compare:
<standardlanguage>en</standardlanguage>

The following locale values are possible:

ca to Catalan(Catalan)
pt_br to Portuguese(Brazil)
de to German(Germany)
ru to Russian(Russia)
pt to Portuguese(Portugal)
it to Italian(Italy)
zh to Chinese Simplified 
cs to Czech(Czech Republic)
fr to French(France)
es to Spanish(Spain)  
en to English(United States)   

English
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Feature Default
value

Invitation text - Other Language

Compare:

<inv_ca>False</inv_ca>     Catalan(Catalan)
<inv_pt_br>False</inv_pt_br>    
 Portuguese(Brazil)
<inv_de>False</inv_de>     German(Germany)
<inv_nl>False</inv_nl>     Dutch (Belgium)
<inv_ru>False</inv_ru>     Russian(Russia)
<inv_pt>False</inv_pt>     Portuguese(Portugal)
<inv_it>False</inv_it>     Italian(Italy)
<inv_zh>False</inv_zh>     Chinese Simplified
<inv_cs>False</inv_cs>     Czech(Czech Republic)
<inv_fr>False</inv_fr>     French(France)
<inv_es>False</inv_es>     Spanish(Spain)
<inv_en>True</inv_en>       English(United States)

English

After making the desired changes to the components, you need to add the
content you have modified to the _._._.userscript file. In the following
example, you can view the place where the changed content (highlighted with
bold) should be added:

<configuration>
  <pc._._>
    <siemens.opticlient>
      <startup>       
        <lastlocation>OPENSCAPE</lastlocation>
        <linmode>None</linmode>       
        <locationselection>True</locationselection>       
        <languageselection>False</languageselection>       
        <usewindowslogin>True</usewindowslogin>       
        <listusers>True</listusers>            
              <useoslanguage>True</useoslanguage>         
   
              <adminmode>Full</adminmode>
      </startup>
    </siemens.opticlient>
  </pc._._>
  <_.user._>
    <siemens.opticlient>
      <startup>
        <password>#</password>       
        <colorscheme>DarkGray</colorscheme>
      </startup>
    </siemens.opticlient>
    <unify.opticlient.pluginintegration.pluginintegration>
       <usepresencesynchronization>True</
usepresencesynchronization>
       <usedefaultconferencingoptions>False</
usedefaultconferencingoptions>
       <audioconferencerecordname>False</
audioconferencerecordname>
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       <audioconferencemoderatedconference>False</
audioconferencemoderatedconference  
       <audioconferencedialoutdefault>False</
audioconferencedialoutdefault>  
       <standardlanguage>en</standardlanguage>
       <inv_ca>False</inv_ca>
       <inv_zh>False</inv_zh>
       <inv_cs>False</inv_cs>
       <inv_nl>False</inv_nl>
       <inv_en>True</inv_en>
       <inv_fr>False</inv_fr>
       <inv_de>False</inv_de> 
       <inv_it>False</inv_it>
       <inv_pt_br>False</inv_pt_br> 
       <inv_pt>False</inv_pt>
       <inv_ru>False</inv_ru>
       <inv_es>False</inv_es>
    </unify.opticlient.pluginintegration.pluginintegration>
  </_.user._>
</configuration>

6.2 How to perform a repair of OpenScape Add-ins

You can repair the installation of OpenScape Add-ins via Windows Control
Panel (in the Programs and Features area) or via the command line, using the
following command:

OpenScapeAddIns.exe /repair

6.3 How to find errors during the OpenScape Add-ins installation

Several log files are created during the OpenScape Add-ins installation process.
You can use the log files for troubleshooting purposes.

Step by Step

During the installation, any data you have specified in the setup command is
written in the log file.

Example of a setup command:
OpenScapeAddIns.exe /norestart /log “%TEMP%
\install_odc.log” /q

NOTICE:  You can use the echo command to get the value of a
Windows environment variable.

For example, the output of the echo %TEMP% command can be:
C:\Users\<user name>\AppData\Local\Temp

or
C:\Users\shi\AppData\Local\Temp

You can use the set command to get the values of all Windows
environment variables.
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6.4 How to uninstall OpenScape Add-ins via Mass Installation

You can uninstall OpenScape Add-ins via the command line, using the following
command:

OpenScapeAddIns.exe /uninstall
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7 How to access OpenScape Add-ins in Microsoft Outlook
The OpenScape Add-ins integration allows you to access OpenScape UC
features directly from Microsoft Outlook via:

• Microsoft Outlook Ribbon
• Microsoft Outlook Reading Pane
• Microsoft Outlook Context Menu
• Microsoft Outlook Contact Card

7.1 OpenScape Add-ins tab in Microsoft Outlook Ribbon

Once the OpenScape Add-ins integration is installed, a new button ( ) is
added to the Microsoft Outlook Ribbon.

NOTICE:  You can display the Microsoft Outlook Ribbon via the
Home tab.

You can click this button to view a list of features that you can access directly
from Microsoft Office.

The following features are available:

• Contacts

This tab displays your list of UC contacts. You can filter the list to display
specific groups of contacts.

• Call History

This tab displays a list of all your incoming and outgoing calls.
• Conferences

This tab displays your list of conferences with additional details such as the
Bridge number, PIN and date/time of scheduled conferences. From here you
can access more details for each conference or initiate conference calls.

• Surveys

This tab displays a list of surveys you have created (if any). From here you
can create a new survey, edit an existing one, see, clear or print responses
and send survey invitations to other users.

• Voicemail

This tab displays a list of your voicemails. You can listen to or download
your voicemail messages and see additional details such as the message
duration and the sender.

• Chat

This tab displays a list of chats you are part of. From here, you can access
additional details such as chat's name, type and creation date and time. You
can also open a chat to see existing messages of send new ones.

When you select a feature in Microsoft Outlook, your OpenScape UC client
cross launches and you are navigated to the corresponding tab.

The Microsoft Outlook Ribbon also allows you set your OpenScape UC
presence status directly from Microsoft Outlook.
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7.2 OpenScape Add-ins in Microsoft Outlook Reading Pane

Once the OpenScape Add-ins integration is installed, the following new options
are available in the Microsoft Outlook Reading Pane:

• Initiate an OpenScape call with the email originator.
• Start a Chat with the email originator.
• Activate Tell-me-when.
• Start a Conference with the email originator or the distribution list.

You can display, customize or change the location of the Reading Pane in
Microsoft Outlook, by navigating to View > Reading Pane.

7.3 OpenScape Add-ins in Microsoft Outlook Context Menu

Once the OpenScape Add-ins integration is installed, new options are available
in the Microsoft Outlook Context Menu:

• Initiate an OpenScape call with the email originator.
• Start a Chat with the email originator.
• Activate Tell-me-when.
• Start a Conference with the email originator or the distribution list.

7.4 Microsoft Outlook Contact Card

Once the OpenScape Add-ins integration is installed, the following options
become available in Microsoft Outlook, via email originator's Contact Card:

• Start an audio call
• Start a chat

You can display someone's contact card by clicking on a person's picture (or
name with a presence icon), then clicking Contact >.

7.5 Microsoft Outlook message preview

Once the OpenScape Add-ins integration is installed, the following options
become available when you read an email in message preview:

• Call originator's business number
• Start a conference with people for the email
• Start a chat
• Activate Tell-me-when

You can display an email in message preview by clicking on in the Microsoft
Outlook Reading Pane. The OpenScape UC options are displayed in the upper
part of message preview.
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8 How to use OpenScape Add-ins in Microsoft Outlook

8.1 How to initiate a call via OpenScape Add-ins

You can initiate OpenScape UC calls from Microsoft Outlook in one of the
following ways:

•
Click  in Microsoft Outlook Reading Pane or in email preview to call the
email originator/s.

• Click  Connect to in Microsoft Outlook Ribbon, then search for an
OpenScape UC contact or enter a phone number to call.

• Click  in a contact card to call the email originator's bussiness number.

When making an OpenScape UC call from Microsoft Outlook, it will cross
launch your OpenScape UC client and use it to initiate the call. The call is
initiated from OpenScape UC Desktop App (default), softphone or desk phone,
depending on what you have selected as calling device.

All calls initiated from Microsoft Outlook are displayed in OpenScape UC as any
other call.

8.2 How to select incoming and outgoing devices in OpenScape Add-ins

You can select the preferred device to be used for incoming and outgoing calls
as well as access additional device settings directly from Microsoft Outlook.

You can do this from the OpenScape Add-ins area in Microsoft Outlook Ribbon.

Procedure

• Follow the steps below to select an incoming device:
a) Click  WebRTC in Microsoft Outlook Ribbon.
b) Under Incoming calls, select one of the available options:

– Work phone
– Softphone
– WebRTC (default)

• Follow the steps below to select an outgoing device:
a) Click  WebRTC in Microsoft Outlook Ribbon.
b) Under Outgoing calls, select one of the available options:

– Same as incoming (default)
– Work phone
– Softphone
– WebRTC

• Follow the steps below to access additional device settings:
a) Click  WebRTC in Microsoft Outlook Ribbon.
b) Click Device settings.

Your OpenScape UC client cross-launches and you are navigated to the
Devices tab.

c) Adjust the settings according to your needs and click Save.
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8.3 How to set your presence status in OpenScape Add-ins

Your presence status lets people know if you are available for communication or
not.

You can manually set your presence status via the OpenScape Add-ins area in
Microsoft Outlook Ribbon. The following presence or availability statuses are
available:

•  Available
•  Away
•  Do not disturb
•  Be right back
•  Busy
•  In meeting

Your presence status in Microsoft Outlook is synchronized with your presence
status in OpenScape UC. The presence synchronization is bidirectional,
meaning that changing your presence status in one app will be automatically
reflected in the other app.
Your availability in OpenScape UC is affected by external Microsoft Outlook
events. For example, your OpenScape UC presence status becomes In
meeting when you have a meeting appointment in your Microsoft Outlook
calendar.

8.4 How to search for a contact in OpenScape Add-ins

You can search for a UC contact or dial a contact's phone number via the
OpenScape Add-ins integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2) Click  Connect to in the Microsoft Outlook Ribbon.

An input field is displayed.
3) Type the name of a UC contact or dial their phone number.

A list of UC contacts that match your search is displayed (if any).
4) Hover your mouse over the desired contact and choose one of the available

options:

•
Click  to call the contact's phone number.

•
Click  to view a list of the communication options available for the
contact selected .

•
Click  to add the contact selected to the action bar.

From here, you can do one of the following actions:

–
Click  to call the contact.

–
Click  to create a conference, add to chat or send an email to the
contact.
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8.5 How to access conferences from OpenScape Add-ins

You can access the list of UC conferences you are part of via the OpenScape
Add-ins integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2)

Click  in the Microsoft Outlook Ribbon and select Conferences.
Your OpenScape UC client cross-launches and you are navigated to the
Conferences tab.

A list of conferences that you are a part of is displayed.

8.6 How to start a conference in OpenScape Add-ins

You can start a UC conference directly from Microsoft Outlook in one of the
following ways:

•
Click  in Microsoft Outlook Ribbon and select Conference.

This will cross launch your OpenScape UC client and navigate you to the
Conferences tab. From here, you can create a new conference or start an
existing one.

•
Right-click an email in the Microsoft Outlook Reading Pane, then select .

A pop-up window is displayed and you can set the conference title or add
more participants.

Click Start to start the conference.
•

While an email is in message preview, click  at the top part.

A pop-up window is displayed and you can set the conference title or add
more participants.

Click Start to start the conference.

Conferences scheduled using the OpenScape Add-ins integration are also
displayed in the Microsoft Outlook calendar.

8.7 How to access chats via OpenScape Add-ins

You can access your UC chats via the OpenScape Add-ins integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2)

Click  in the Microsoft Outlook Ribbon and select Chat.
Your OpenScape UC client cross-launches and you are navigated to the
Chats tab.

A list of chat conversations you are part of is displayed.
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8.8 How to start a chat in OpenScape Add-ins

You can start a chat with directly from Microsoft Outlook in one of the following
ways:

• Right-click an email in the Microsoft Outlook Reading Pane, then select
Chat.

•
While an email is in message preview, click  at the top part.

8.9 How to access call history from OpenScape Add-ins

You can access your UC call history via the OpenScape Add-ins integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2)

Click  in the Microsoft Outlook Ribbon and select Call history.
Your OpenScape UC client cross-launches and you are navigated to the Call
history tab.

A list of incoming and outgoing calls to your OpenScape UC client is
displayed.

8.10 How to access surveys via OpenScape Add-ins

You can access your UC surveys via the OpenScape Add-ins integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2)

Click  in the Microsoft Outlook Ribbon and select Surveys.
Your OpenScape UC client cross-launches and you are navigated to the
Surveys tab.

A list of existing surveys (is any) is displayed.

8.11 How to access your voicemail via OpenScape Add-ins

You can access your voicemail messages via the OpenScape Add-ins
integration.

Step by Step

1) Open the Microsoft Outlook app and navigate to the Home tab.
2)

Click  in the Microsoft Outlook Ribbon and select Voicemail.
Your OpenScape UC client cross-launches and you are navigated to the
Voicemail tab.

A list of voicemail messages (if any) is displayed.
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8.12 How to activate Tell-me-when in OpenScape Add-ins

You can activate Tell-me-when via the OpenScape Add-ins integration to get
notified when somebody becomes available.

You can activate this option in one of the following ways:

• Right-click an email in the Microsoft Outlook Reading Pane, then select
Activate Tell-me-when.

•
While an email is in message preview, click  at the top part.

8.13 How to create a UC conference

You can create a UC conference directly from Microsoft Outlook using the
OpenScape Add-ins integration.

Step by Step

1) Open Microsoft Outlook and navigate to the Home tab.
2) Click  next to New Items on the Microsoft Outlook Ribbon, then select

Meeting.

The Untitled - Meeting dialog opens.
3) Enter a title for the conference in the Title field.

The conference title will be displayed in Call Control and Call Journal.
4) Add the desired conference participants in the Required and/or Optional

fields.
5) Select the desired start time and end time for the conference.

Alternatively, you can schedule a recurring meeting by clicking Make
Recurring and then selecting the appointment time, recurring pattern and
range of recurrence.

NOTICE:  OpenScape Add-ins does not allow scheduling all
day events.

6)
Click  Add Conference on the Microsoft Outlook Ribbon.

The OpenScape conference dialog opens.

Depending on your OpenScape Add-ins configuration settings, specific
options may be preconfigured. For more information about the OpenScape
Add-ins settings, see How to configure OpenScape Add-ins settings on page
28.
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7) Configure the conference settings:

a) In the Title field, you can change the conference title that you have
specified when creating the meeting request or that was automatically
generated by the system.

b) In the Participants section, you can change the following parameters:

• The phone number to be used for calling the conference participants.
• The role of participants (invitee or moderator), in case of a moderated

conference.
• The way participants will join the conference (call in or call out).

NOTICE:  You can change the way participants join
the conference even if you have enabled the Dial out
to participants option in the OpenScape Add-ins
settings.

c) In the Invitation text section, you can select the desired language/s to be
used for the invitation text.

d) In the Audio conference section, you can select the following options:

• Enable the Moderated conference option if you want to schedule a
moderated conference.

NOTICE:

For moderators, more options to control the
conference are available compared to other
conference invitees.

Moderated conferences require the presence of a
moderator. If a moderator is not in the conference,
other participants that have dialed in will hear the on-
hold music until a moderator joins the conference. In
case of dial-out conferences, a moderator must start
the conference.

If you want to schedule an open conferences, the Moderated
conference option needs to be disabled.

NOTICE:  Open conferences start when the first
participant joins the conferences.

All participants have the same options to control the
conference.

• Enable the Record name option if you want to record the names of
the conference participants.

NOTICE:  If this option is enabled, conference
participants must specify their name before joining the
conference.
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8) Click Ok.

The conference is created and you can view the following information in the
subject area of the meeting dialog:

• The conference title
• The creator of the conference
• The date and time when the conference is scheduled
• A link to join the conference
• The bridge number and pin of the conference
• Other bridge numbers

NOTICE:  The system sends the invitation in text-only format.
Any text formatting applied to the invitation text (font, size
etc.) will be ignored when the meeting request is sent.

9) Click Send to send the invitation to the conference participants.

A meeting appointment is added to your Microsoft Outlook calendar.

8.13.1 How to modify a UC conference

You can modify a UC conference that you have previously created directly from
Microsoft Outlook.

NOTICE:  You can only modify a UC conference before its start
time. After the conference start time, you can only delete a UC
conference.

Step by Step

1)
Open Microsoft Outlook click  on the left navigation bar to open the
Microsoft Outlook calendar.

2) Locate the conference you want to delete and double click on it.
3)

Click  Modify OpenScape Conference on the Microsoft Outlook Ribbon.
The OpenScape conference dialog opens.

4) Modify the desired conference parameters, then click Ok.
5) Click Send to send an updated conference invitation.

The conference is updated according to the changes you have made.

8.13.2 How to delete a UC conference

You can delete a UC conference that you have previously created directly from
Microsoft Outlook.
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Step by Step

1)
Open Microsoft Outlook click  on the left navigation bar to open the
Microsoft Outlook calendar.

2) Locate the conference you want to delete and double click on it.
3)

Click  Delete Conference on the Microsoft Outlook Ribbon.
4) Click Ok to confirm the delete action.

The conference is removed from your Microsoft Outlook calendar.

8.13.3 How to start a UC conference

You can start a UC conference directly from Microsoft Outlook.

Step by Step

1)
Open Microsoft Outlook and click  on the left navigation bar to open the
Microsoft Outlook calendar.

2) Locate the conference you want to start and double click on it.
3)

Click  Start OpenScape Conference on the Microsoft Outlook Ribbon.

Your OpenScape client opens and the conference is started.
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9 How to access OpenScape Add-ins from system tray
OpenScape Add-ins provides system tray functionality that allows you to easily
access specific features without the need to open the Microsoft Outlook client.

To access OpenScape Add-ins from the system tray, click  on the right side
of the task bar, then right-click on the OpenScape Add-ins icon ( ). You can
select one of the options available:

• Errors and Warnings, to displays the current error report.
• Settings, to view or edit configuration settings.
• Info, to view more information about the OpenScape Add-ins integration.
• Exit, to stop OpenScape Add-ins from running.

9.1 How to configure OpenScape Add-ins settings

You can access the OpenScape Add-ins settings from the Windows System
Tray. In this area, you can edit your presence and conference settings and
select the desired language/s in which conference invitations are sent out to
participants.

Step by Step

1) Click  on the right side of the task bar to open the system tray.
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2) Right-click on the OpenScape Add-ins icon, then select Settings.

The Settings window opens and you can view the configuration options
available.

You can edit the configuration settings according to your needs:

• Enable the Change user presence to "In a meeting" option to allow
changing your presence status to In a meeting automatically, for the
conference duration.

• Enable the Create conference with default settings option to skip
opening the settings dialog for individual conference configuration, when
you click the OpenScape Add conference button.

• Enable the Request username option to request each conference
participant to specify their name before joining a conference. If you
enable this option, participants are only allowed to join conferences after
entering their name.

• Enable the Moderated conference option if you want to configure a
moderated conference. If you enable this option, only a moderator can
start and control moderated conferences.

• Enable the Dial out to participants option to allow the system to call all
conference participants automatically when a conference is started.

• Select the language to be used for the conference invitation text from the
Standard Language drop-down menu. By default, the language selected
during your Microsoft Outlook client installation is used. You can select
additional languages for the conference invitation text by clicking the
desired language/s in the Other Language box.
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3) Click Ok to save the configuration changes.
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10 How to update OpenScape Add-ins
When a new version of the OpenScape Add-ins integration is available, a
banner is displayed in the OpenScape Desktop App, prompting you to install the
latest version.

Prerequisites

• You have previously installed the OpenScape Add-ins integration.

Step by Step

1) In your UC client, click on your user name, then select Settings > General.
2) Locate the OpenScape Add-ins area and click Download OpenScape

Add-ins.
A zip file containing the latest version of the integration is downloaded to
your computer.

3) Locate the zip file (usually in the Download folder) and extract it.

The following file is extracted:

• OpenScapeAddIns.exe

4) Double-click on the OpenScapeAddIns.exe file to install the latest version
of the integration.
The installation wizard opens.

5) Follow the instructions on the installation wizard.
6) Click Ok to save the configuration changes.

The latest version of OpenScape Add-ins is installed on your computer.

To successfully complete the update process, you might be prompted to:

• Stop any running instances of OpenScape UC Connector.
• Restart the Microsoft Outlook client.
• Restart the UC Desktop App client.
• Restart your computer.
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